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Preface

This manual assumes that you are familiar with the development and design of integrated 
circuits. It contains task-related information about the Dracula® graphical user interface which 
belongs to the Dracula group of physical verification and analysis products. 

The Dracula graphical user interface's executable in the IC 5.1.41 and IC 6.1.x releases is 
called draculaInteractive. You can access its functionality in standalone mode or via a 
DFII session. The Cadence® design framework II software refers to it in its user interface as 
the Dracula Interactive product. Refer to the previous versions for information on its former 
names.

The preface discusses the following:

■ Related Documents

■ Typographic and Syntax Conventions

Related Documents

For more information about the Dracula graphical user interface and other related products, 
you can consult the sources listed below.

■ The Dracula Graphical User Interface Reference describes the Dracula graphical user 
interface menu commands.

■ The Virtuoso Layout Editor User Guide provides information about the Tools, Design, 
Window, Create, Edit, Verify, Connectivity, Options, and Route menus. 

■ The Cadence Installation Guide tells you how to install the product.

■ The Dracula Standalone Verification Reference and the Dracula User Guide tell you how 
to use the Dracula® standalone verification product to verify your design.

Typographic and Syntax Conventions

Here are some conventions used to describe menu commands.
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Boxes and arrows in a sequence like the one below show you the order in which you select a 
command from a menu.

Each form shows you the system defaults:

■ Filled buttons are the default selections. 

■ Filled-in values are the default values.

Setup➃DRC
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1
Getting Started

This chapter deals with the basics of getting started with the Dracula® graphical user interface 
which belongs to the Dracula group of physical verification and analysis products. 

The Dracula graphical user interface's executable in the IC 5.1.41 and IC 6.x releases is 
called draculaInteractive. You can access its functionality in standalone mode or via a 
DFII session. The Cadence® design framework II software refers to it in its user interface as 
the Dracula Interactive product. Refer to the previous versions for information on this 
product’s former names.

Note: Throughout this manual, when just the words “graphical user interface” is used, it refers 
to the Dracula graphical user interface product.

.This chapter discusses the following topics:

■ “About the Dracula Graphical User Interface” on page 9

■ “How to Use This Tutorial” on page 10

■ “Preparing to Start the Dracula Graphical User Interface” on page 10

About the Dracula Graphical User Interface

When you use the Dracula® product to check whether you wrote your design rules correctly 
or to find and fix Dracula errors in your layout, the results can be difficult to analyze. One way 
to find Dracula Design Rule Checking (DRC) or Layout Versus Schematic (LVS) errors is to 
overlay the Dracula results on your layout and zoom in on each error manually. The problem 
with this method is that errors can be hard to see and keep track of, particularly in a dense 
layout. There is no way to access specific errors automatically.

The graphical user interface helps solve this problem. With the graphical user interface 
commands, you control which Dracula verification errors you want to see. You can cycle 
through errors automatically while the graphical user interface keeps track of the errors you’ve 
seen. When you use the graphical user interface to find and keep track of Dracula verification 
errors, you can resolve errors faster.
September 2023 9 Product Version IC23.1
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To correct Dracula errors in your layout, you can use the graphical user interface with your 
layout data to locate these errors. The graphical user interface works with any system that 
you use to create your original layout data. If you use the Virtuoso® layout editor, you can 
display both the layout and Dracula error files in the the graphical user interface window. If 
you use a layout tool other than the Virtuoso layout editor, you need to open the layout window 
separately from the graphical user interface window.

To verify the rules in your command file, you do not need to display the layout data. In this 
case, you use the graphical user interface to determine whether you wrote the rules correctly 
and whether Dracula flagged the errors as you intended. 

This tutorial shows you how to use the graphical user interface to identify and display DRC 
and LVS results.

How to Use This Tutorial

In this tutorial, you will learn how to

■ Display DRC errors in a flat design

■ Display DRC errors in a hierarchical design

■ Display and analyze LVS errors

■ Display parasitic resistance and capacitance (RC)

Start with “Preparing to Start the Dracula Graphical User Interface” on page 10. This section 
helps you learn how to set up the software you will use in each of the DRC and LVS chapters.

After you set up the software, you can work through the chapters in this tutorial in any order.

Preparing to Start the Dracula Graphical User Interface

To do this tutorial, you need to copy the sample files to your own directory. Once you’ve copied 
the files, you’ll start the software and open an empty cell.

In this chapter, you’ll learn how to

■ Copy the sample tutorial files

■ Start the Cadence software

■ Use the Command Interpreter Window (CIW)

■ Use forms and menus
September 2023 10 Product Version IC23.1
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■ Create an empty cell in which you can display data in the graphical user interface

■ Open the empty cell

Copying the Sample Files

To perform the steps in this tutorial, you must use the tutorial files. The files you need to run 
the tutorial are in the directories dracrun and drchier. The paths to the directories are 
shown in the table below. If the dracrun and drchier directories are not there, contact your 
Cadence sales representative or customer support person.

Note: In the paths listed below, your_install_dir is the highest level in your Cadence 
directory hierarchy.

Before you start the tutorial, do the following:

1. Create a new directory called tutorial.

2. Create a new directory called tutorial/dracrun.

3. Create a new directory called tutorial/drchier.

4. Create a new directory called tutorial/dracrc.

5. Change your working directory to the tutorial/dracrun directory.

6. Copy the dracrun files into the tutorial/dracrun directory.

7. Change your working directory to the tutorial/drchier directory.

8. Copy the drchier files into the tutorial/drchier directory.

Directory Contents Path to the directory

dracrun Directory containing the 
flat DRC and LVS data 
you use for this tutorial.

your_install_dir/tools/dfII/samples/
tutorials/inq/dracrun

drchier Directory containing the 
hierarchical DRC data 
you use for this tutorial.

your_install_dir/tools/dfII/samples/
tutorials/inq/drchier

dracrc Directory containing the 
parasitic RC data you 
use for this tutorial.

your_install_dir/tools/dfII/samples/
tutorials/inq/dracrc
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9. Change your working directory to the tutorial/dracrc directory.

10. Copy the dracrc files into the tutorial/dracrc directory.

Now the tutorial files are ready for you to use them.

Starting Cadence Software

Each company has its own way to start Cadence software. Ask your system administrator 
how to log on and what command to type to start the software. If you have a Sun workstation, 
you also need to know how to start the X Window System software. Once you have this 
information, follow these steps.

1. Log on to your system.

2. If you have a Sun workstation, start the X Window System software. If you have a 
different workstation, go on to the next step.

3. Type your command for starting Cadence software at the system prompt.

In a few moments, you’ll see the Command Interpreter Window (CIW). The Cadence® 
design framework II commands are located on menus at the top of the CIW, as shown.

You’ll see your 
working path here.
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Using the CIW

The CIW is the control window for the Cadence software. The following figure shows the parts 
of the CIW.
 

Window title displays the Cadence executable name and the path to the log file that records 
your current editing session. The log file is in your home directory.

Menu banner lets you display command menus to access the graphical user interface.

Output area displays a running history of the commands you run and their results. For 
example, it displays a status message when you open a library.

Input line is where you type in SKILL expressions or enter numeric values for commands.

Prompt line reminds you of the next step during a command.

Using Forms and Menus

Most of the menus you use in the Cadence software are pull-down menus. Pull-down menus 
appear at the top of a window. You click the left mouse button on a menu title to “pull down” 
the menu and see the commands on it. The pull-down menus are the primary place to find 
commands. 

Three dots (...) follow some commands. These dots mean that a “form” appears after you click 
on the command. Many commands have forms you use to provide additional information.

Window title

Menu banner

Output area

Input line

Prompt line
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To use the following form banner buttons, you click on them with the left mouse button.

Note: Pressing Return has the same effect as clicking left on OK.

Using the Mouse

In this tutorial, “click left” means to press and release the left mouse button. If you need to 
click on a different mouse button, it will always be specified. 

When you are asked to “select” commands from a menu, you click the left mouse button on 
the main menu, then on the command. For example, “Select Library Manager from the 
Tools menu” means to click the left mouse button on Tools to display the menu, then click 
the left mouse button on Library Manager.

When you are asked to “double click,” you click the mouse button twice without moving it.

Starting the Standalone Dracula Graphical User Interface

Instead of starting the Cadence layout software, you can start the standalone Dracula 
graphical user interface by typing the following command at the UNIX command line:

OK

Displays the default 
values for options on 
the form

Displays the reference 
manual page that 
describes the command

Removes the form without 
starting any additional 
commands

Starts the command and 
keeps the form on the 
screen

Starts the 
command and 
removes the form

HelpApplyDefaultsCancel
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draculaInteractive &

Creating an Empty Cell

Before you can display the sample Dracula data for this tutorial, you need to create an empty 
or “dummy” cell in which to put the data. The empty cell lets you access the graphical user 
interface menu commands. You use the same empty cell in each chapter of this tutorial. You 
need to create the empty cell only once.

1. In the tutorial directory, start the Cadence CIW or the Standalone Dracula graphical 
user interface window.

2. To display the Create Dummy Cell form of the graphical user interface, do one of the 
following:

❑ In the CIW, type iqCreateDummyCell and press Return. 

❑ In the Dracula graphical user interface window, click on the menu command Utility 
– Create Dummy Cell. 

The Create Dummy Cell form appears.

3. In the form, type dracrun and the names of the new library and new cell. 

draculaInteractive - Log:/usr1/mnt/dracula/CDS.log
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Note: To move between the fields in a form, press the Tab key.

4. Click left on OK.

After a few seconds, the form disappears and a message appears in the CIW to tell you 
that the cell was created successfully. Now that you’ve created the empty cell, you can 
open it and access the graphical user interface commands.

Opening the Empty Cell

To open the new empty cell you created, you’ll use the Library Browser.

1. In the CIW, select File – Open.

Type dracrun here.

Type newlib here.

Type newcell here.

To display addiitonal information about the contents of any 
form, click on the Help button in the right corner of the form.
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The Open File form appears.

2. From the Library Name menu, select newlib.

The Open File form is completed when newcell appears in the Cell Name field.

3. To open newcell, in the Open File form, click OK.

Note: If you select a menu accidentally, click anywhere outside the menu to close it. If 
you select a command accidentally, click on Cancel in the command form to cancel the 
command.

The graphical user interface window that displays the empty cell opens in edit mode, 
which means you can edit the cell. You will use this cell to display Dracula data. The 
menu banner in the empty cell looks like this:

4. From the menu banner, select Tools – Dracula Interactive.

You use the left mouse button to select menus and commands.

Open File

/mnt3/user4/test/tutorial/cds.lib

Tools Design  Window Create Edit Verify Connectivity .Options Route
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The menu banner changes to display the graphical user interface menus. Except for the 
new menus, the Dracula graphical user interface window does not change.

Now you are ready to start any of the DRC, LVS, or LPE chapters.

Reopening an Empty Cell

At some point, you might want to close the windows and quit the tutorial. To resume the 
tutorial later, you can reopen the dummy cell as follows.

1. In the CIW or the graphical user interface window, click on File – Open.

2. When the Open File form is displayed, select newlib from the Library Name menu.

3. Be sure that newcell is displayed in the Cell Name field.

4. In the Open File form, click OK.

5. When the design window is open, from the menu banner, select Tools – Dracula 
Interactive.

Now that you’ve got your dummy cell open again, you’re ready to resume working 
through the tutorial.

Tools Design Window DRC LVS  Short  LPE Create  Edit  Verify Connectivity Options Route
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2
Displaying DRC Errors in a Flat Design

This chapter relates to the Design Rule Checking (DRC) commands in the Dracula® graphical 
user interface and covers the following topics

■ About Flat DRC

■ Starting DRC

■ Defining How to Display DRC Errors

■ Displaying DRC Errors

■ Verifying DRC Rules

■ Keeping Track of Errors You’ve Seen

■ Quitting the Tutorial

■ Summary

About Flat DRC

When you run a flat DRC, Dracula creates error files for each of the design rule checks. In 
this chapter, you’ll learn how to use the graphical user interface to display Dracula data. You’ll 
use the the graphical user interface commands to locate and examine error flags in these files 
automatically, while the graphical user interface keeps track of which errors you’ve seen.

The procedures in this tutorial use Dracula output error files, not the original layout data. 
Because Dracula output data is in a different format, data you’ll see in this tutorial won’t look 
like your original layout data.

In this chapter, you will learn how to

■ Start the graphical user interface DRC

■ Select DRC error files to display

■ Define how to display DRC errors
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■ Display DRC errors

■ Verify DRC rules

■ Keep track of which errors you’ve seen

■ Quit the Cadence software

Starting DRC

You need to create and open an empty cell, which is explained in Chapter 1, “Creating an 
Empty Cell.” Once you have an empty cell open, you can go on with this section.

After you open the empty cell, the Dracula graphical user interface window appears. This 
graphical user interface window and the Layer Selection Window (LSW) are the only two 
windows open. You can ignore the LSW for now.

Accessing Dracula Error Files in the Dracula Graphical User Interface 
Window

In order to tell the software where to find your Dracula error files follow these steps.

1. To display the DRC commands, click left on the DRC menu.
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2. Select Setup from the DRC menu.

The DRC Setup form appears.

3. To tell the Dracula graphical user interface where to find your Dracula DRC files, in the 
Dracula Data Path field, type dracrun.

If you did not start the software in the directory where the Dracula DRC files are located, 
you must type the complete path to the files.

4. Click left on OK. 

Note: The form takes a few seconds to disappear. 

All is the default. This 
specifies that you want to 
check all the rules files.
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The graphical user interface window opens displaying all the error flags.

The following windows appear:

■ Dracula Layer Window

The Dracula Layer Window (DLW) appears on the left side of your screen and covers the 
Layer Selection Window (LSW). The DLW shows the original layers in your design after 
you run Dracula. You use the DLW to select the layers you want to view.

■ View DRC Error window

The View DRC Error window opens at the right side of your screen. This window lets you 
cycle through and manage DRC errors in the graphical user interface window.

■ Reference Window

The Reference Window opens at the bottom left of your screen. This window shows the 
entire the graphical user interface window on a small scale and helps you determine 

Tools Design Window DRC LVS Short LPE Create Edit 
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where you are in the design window. You can use the Window – Zoom Reference 
Area command to have the the graphical user interface window zoom to the area you 
specify in the Reference Window.

■ Rules Layer Window

The Rules Layer Window opens at the bottom of your screen. This window lists DRC 
error files and lets you select errors you want to view in the graphical user interface 
window.

You will use these windows later in this tutorial. For now, you can ignore them.

Now the graphical user interface knows where to find your Dracula DRC error files. Next you’ll 
select individual error files you want to display.

Defining How to Display DRC Errors

To help you distinguish different types of errors, you set the way you want error flags to appear 
in the graphical user interface window. For this chapter, you’ll display error flag outlines.

Displaying Error Flags

1. To set how error flags are displayed, from the DRC menu, select Display Options.

The DRC Options form appears. 
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2. Select the following options.

The graphical user interface window is automatically updated when you select display 
options. You might want to leave this form up so you can quickly change how error flags 
are displayed. To close the form, click OK.

You just specified how you want errors to be displayed. Next you’ll display the errors.

Displaying DRC Errors

A Dracula run often generates several DRC error files. To minimize the number of error flags 
in the graphical user interface window, you might want to display only a few errors at one time. 
For this chapter, you’ll zoom in on each contact-to-via error.

Selecting Error Files

1. In the Rules Layer Window, click left on CNTVIA06.DAT.

This makes the CNTVIA06.DAT error your current error file.

DRC Options

Select All in Visible 
Rules to make all layers 
selected in the View DRC 
Error form visible.
Select Edge so only edges 
of errors are displayed.

Select In Window to view 
error explanations in a 
separate window.
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2. In the View DRC Error window, select Fit Current Error.

The first contact-to-via error appears in the graphical user interface window.

A window explaining the error appears in the upper right corner of your screen. You can ignore 
this window for now.

To view the 
CNTVIA06.DAT error, 
select Fit Current Error.

CNTVIA06.DAT

Tools Design Window DRC LVS Short LPE Create Edit Verify 
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1. To display the layout layers associated with this error, from the Display With field on the 
DRC Options form, select Source Layer.

The graphical user interface window is automatically updated to show the source layers 
for the CNTVIA06.DAT error. In this case, the layers that are CONTACT and VIA, the 
layers that are the source of the error.

Select Source Layer.

Tools Design Window DRC LVS Short LPE 
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You’ve just displayed the Dracula layers for an error flag. Next you’ll examine and verify the 
cause of these contact-to-via spacing error flags.

Verifying DRC Rules

Now that you’ve seen the contact-to-via spacing error, you’re ready to determine the cause of 
the problem.

Displaying DRC Rules

1. In the View DRC Error window, click left on Explain.

2. Click left on one of the DRC flags in the graphical user interface window.

To see the cause of 
the error, click on 
one of the error 
flags.

Tools Design Window DRC LVS Short LPE
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The error window at the top of the screen explains the cause of the error.

3. To close the text file, from the File menu, select Close Window.

To verify that the error explanation reflects the problem in the design, you’ll measure the 
space between the contact and via Dracula layers.

4. Click left on the ruler at the bottom of the icon menu on the left of the graphical user 
interface window.

Note: The locations of the commands in your icon menu might be different. To see the 
command name associated with an icon, move the cursor over the icon.

You see that this error is 
caused by contact-to-
via spacing of less than 
0.6 microns.
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5. Use the ruler to measure the space between the shapes.

You see that this spacing is less than the required 0.6 microns.

1. To remove the ruler, go to the Misc menu and select Clear Rulers.

Now that you know how to display and verify errors, you need a way to keep track of 
which errors you’ve seen. Next you’ll display the error status report, which helps you 
automatically keep track of which errors you’ve seen.

Keeping Track of Errors You’ve Seen

To keep track of all the errors that resulted from your Dracula DRC run, you use the error 
status report. This report is a text file that provides information about these errors.

You use the ruler to 
verify that the 
contact-to-via 
spacing is less 
than .6 microns.

To start the ruler, 
click left here.

2. Click left to 
place the second 
point of the ruler 
here.

1. Click left to 
place the first 
point of the ruler 
here.

Tools  Design  Window  DRC  LVS  Short  LPE  Create  Edit  Verify  Connectivity   

0

.30
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Displaying the Error Status Report

1. To display the error status report, from the View DRC Error window, select Commands – 
Error Status.

The DRC Error Query Status form appears.

Note: You can use this form to save your place in the error file so you can start with the 
same error when you begin the next session.

2. To display the error status report, click left on Show Current Status.
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The status text file appears. 

3. To close this text file, from the File menu, select Close Window.

Quitting the Tutorial

At this point, you might want to continue working with the graphical user interface. If you’d like 
to continue, you can leave the windows you used for the tutorial on the screen or you can 
close them. If you want to close the windows, go to the “Closing Windows” section.

When you are ready to quit the Cadence software, go to “Quitting Cadence Software” on 
page 33.
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In this section, you’ll learn about

■ Closing windows

■ Quitting Cadence software

Closing Windows

If you want to continue working with the graphical user interface, but would like to close some 
of the windows, follow these steps.

1. To close the graphical user interface window, from the Window menu, select Close.

2. To close a text window, such as the error status report window, from the File menu, select 
Close Window.
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Quitting Cadence Software

To quit the Cadence software, follow these steps.

1. From the File menu in the CIW, select Exit.

A dialog box appears asking if you want to exit.

2. Click left on Yes.

The graphical user interface closes all the windows and returns you to the system 
prompt.

Summary

In this chapter, you learned how to use the graphical user interface to identify and display 
DRC errors in a flat design. Specifically, you learned to

■ Start the DRC command from the graphical user interface’s menu

■ Choose which errors to view

■ Set how you want error flags to appear in the the graphical user interface window

■ Display DRC errors

❑ Display the layers associated with the error flags

❑ Verify the cause of DRC errors

■ Use the error status report to keep track of which errors you’ve seen

■ Quit the Cadence software
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3
Displaying DRC Errors in a Hierarchical 
Design

This chapter deals with Design Rule Checking (DRC) errors in the Dracula® graphical user 
interface and covers the following topics:

■ “About Hierarchical DRC” on page 35

■ “Starting DRC from the Graphical User Interface” on page 36

■ “Selecting Hierarchical DRC Error Files” on page 37

■ “Defining How To Display Hierarchical DRC Errors” on page 39

■ “Selecting Hcells with Errors” on page 40

■ “Displaying Hcell Errors” on page 42

■ “Verifying DRC Rules” on page 43

■ “Keeping Track of Errors You’ve Seen” on page 45

■ “Displaying Hcell Masters” on page 47

■ “Quitting the Tutorial” on page 48

■ “Summary” on page 48

About Hierarchical DRC

When you run hierarchical DRC, Dracula creates error files for each of the design rule checks 
as for flat checking, but it reports them cell-by-cell for cell-based errors rather than flattening 
them. The cells are called Hcells, and error viewing needs to deal directly with this extra 
structure.

In this chapter, you’ll learn how to use the Dracula graphical user interface to display 
hierarchical Dracula data. You’ll use the graphical user interface commands to automatically 
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locate and examine the error flags in these files, while the graphical user interface keeps track 
of which errors you’ve seen. You’ll also learn how to work with Hcells.

The procedures in this tutorial use Dracula output error files, not the original layout data. 
Because Dracula output data is in a different format, data you’ll see in this tutorial won’t look 
like your original layout data.

Starting DRC from the Graphical User Interface

Before you start this section, you need to create and open an empty cell, which is explained 
in the first chapter of this tutorial. If you have not yet started the graphical user interface 
software yet, read Chapter 1, “Getting Started.”

After you open the empty cell, the graphical user interface window appears. The graphical 
user interface window and the Layer Selection Window (LSW) are the only two windows open. 
You can ignore the LSW for now.

Now you’ll tell the software where to find your Dracula error files.

1. To display the DRC commands, click left on the DRC menu.

2. From the DRC menu, select Setup.

The DRC Setup form appears.

3. To tell graphical user interface where to find your Dracula DRC files, in the Dracula Data 
Path field, type drchier.

These commands are disabled. 
To make these commands 
accessible, you need to run the 
Setup and the Select Error 
Files commands.

CustomizeSetup...

Select Error Files...

Display Options...

Text File Handling 

Hierarchical Cell

Get Reference Window

Get Dracula Layer Window

Get DRC Error Window

Get Rules Layer Window

Window     DRC     LVS   Short  LPE    Create  Edit  Verify
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If you did not start the software in the directory where the Dracula DRC files are located, 
you must type the complete path to the files.

4. Click left on OK.

Now the graphical user interface knows where to find your Dracula DRC error files. 

The following windows appear. These windows are described in the section of the previous 
chapter.

■ Dracula Layer Window

■ View DRC Error window

■ Reference Window

■ Rules Layer Window

You’ll use these windows later in this tutorial.

Next you’ll select the error files you want to display.

Selecting Hierarchical DRC Error Files

A Dracula run often generates several hierarchical DRC error files. To minimize the number 
of error flags in the graphical user interface window, you probably want to display only a few 
of the error files at once. 

Next you’ll learn how to tell the graphical user interface which files to display. For this section, 
you’ll need to select the files with metal2-to-metal2 errors.

1. From the DRC menu, select Select Error Files.

The Select DRC Error Files form opens.

2. On the Select DRC Error Files form, select Show Rule/Comment.

Type drchier here.
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3. Keep selected only the MT2MT206.DAT and MT2MT206.ENC error files.

Note: The .ENC error files are Hcell and composite-to-Hcell errors. The .DAT error files 
are composite errors.

4. Click left on OK.

The Rules Layer Window contains only the error files you chose. The graphical user 
interface window shows the contact-to-via errors and metal1-to-metal1 errors.

Select DRC Error Files

Leave only the 
metal2-to-metal2 
error files 
selected.

Tools Design Window  DRC LVS Short LPE Create Edit Verify Connectivity Options Route       Help
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Now that the graphical user interface knows which error files you want to examine, you’re 
ready to display the error flags.

Defining How To Display Hierarchical DRC Errors

To help you distinguish different types of errors, you set the way you want error flags to appear 
in the graphical user interface window. For this chapter, you’ll choose how you want the error 
flags to appear. You can leave the default settings if you want.

1. To change how the error flags are displayed, from the DRC menu, select Display Options.

The DRC Options form appears. 

The window is updated automatically when you select different options.

2. Select All in Active Rule.

The graphical user interface window is updated to show the MT2MT206.DAT errors only 
because this is the active rule in the Rules Layer Window.

3. Select All in Visible Rules.

The graphical user interface window is updated again to show all the MT2MT206.DAT 
and MT2MT206.ENC errors because these are all visible rules in the Rules Layer 
Window.
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You’ve now defined how the MT2MT206.DAT and MT2MT206.ENC error flags appear. 
Next you’ll select an Hcell with errors.

Selecting Hcells with Errors

Before you can see the hierarchical DRC errors in the CNTVIA06.ENC file, you need to select 
the Hcell in which the errors occur. 

1. From the DRC menu, use Select Error Files to add the CNTVIA06.ENC error file to the 
Rules Layer Window.

2. In the Rules Layer Window, click on CNTVIA06.ENC.

3. From the DRC menu, select Hierarchical Cell.

The Handle Hcells form appears. For this tutorial, you’ll select the A0121_B Hcell.

4. Fill out the Handle Hcells form as shown. 

CustomizeSetup...

Select Error Files...

Display Options...

Text File Handling 

Hierarchical Cell..
Get Reference Window

Get Dracula Layer Window

Get DRC ERror Window

Get Rules layer Window

Window     DRC     LVS    Short   LPE Create Edit  Verify
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The graphical user interface window is updated automatically when you select these 
options.

To specify a specific 
Hcell instance, type 
in a placement 
number like 373.

To fit the placement 
containing the current 
error in the Dracula 
graphical user interface 
window, click Fit 
Current.

To turn off the display of all 
instances except placement 
373, click on 
None Visible.

To display the bounding boxes 
of the AOI21_B Hcell, click 
on Visible Cells.

Click OK to dismiss 
the form.

373
September 2023 41 Product Version IC23.1
© 2023                                                                                                                                                               All Rights Reserved.



Dracula Graphical User Interface Tutorial
Displaying DRC Errors in a Hierarchical Design
The graphical user interface window is updated to show placement 373 of the AOI21_B 
Hcell only.

Next you’ll display the error flags in the Hcell you selected.

Displaying Hcell Errors

You can now display the contact-to-via error flags in the AOI21_B Hcell. You’ll zoom in to the 
errors in that Hcell.

1. From the View DRC Error window, click left on Next.

  Tools  Design Window  DRC  LVS  Short   LPE   Create   Edit   Verify   Connectivity   

View DRC Error

CNTVIA06.ENC

Click Next.
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The graphical user interface window zooms to the first error in the current Hcell.

The View DRC Error window is updated to show that you are viewing the first of four 
unfixed errors.

A window explaining the error opens at the top of your screen. You’ll use it later in this 
tutorial.

2. To display the Dracula layers associated with the Hcell error flags, from the DRC Options 
form, select Source Layer.

The graphical user interface window is updated automatically to show the source layers 
for the first error.

Notice that the DLW highlights source layers displayed in the graphical user interface 
window.

Verifying DRC Rules

Now that the error flags are displayed, you can identify the rule that caused these DRC flags.

The text window at the top of your screen gives an explanation of the DRC error you selected 
in the AOI21_B Hcell.

You are viewing the first 
of four unfixed 
CNTVIA06.ENC 
errors.

CNTVIA06.ENC

View DRC Error

You see this error is 
contact-to-via 
spacing of less than 0.6 
microns.
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To verify that the error explanation reflects the problem in the design, you’ll measure the 
space between the contact and via Dracula layers.

1. Click left on the ruler at the bottom of the icon menu on the left of the graphical user 
interface window.

To start the ruler, 
click here.

Tools Design Window DRC  LVS Display 
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2. Measure the distance between the edges of the shapes on each layer as shown in the 
graphic below.

You see that this spacing is less than the required 0.6 microns.

3. To remove the ruler, select Window > Clear All Rulers.

4. From the View DRC Error window, select Next.

The graphical user interface window zooms in to the next error in the current Hcell. Notice 
that the View DRC Error form shows that you are now viewing the second of four unfixed 
CNTVIA06.ENC errors.

Next you’ll learn how to keep track of the errors you’ve seen.

Keeping Track of Errors You’ve Seen

To keep track of all the errors that resulted from your hierarchical DRC run, you use the error 
status report. This report is a text file that provides information about all the errors that 
resulted from your hierarchical DRC run.

1. To display the error status report, from the View DRC Error window, select Commands 
–  Error Status.

Tools  Design  Window  DRC LVS    Short LPE Create Edit Verify Connectivity Options Route               Help 

1. Click left to 
place the first 
point of the 
ruler here.

2. Click left to 
place the 
second point 
of the ruler 
here.

0

0.30
September 2023 45 Product Version IC23.1
© 2023                                                                                                                                                               All Rights Reserved.



Dracula Graphical User Interface Tutorial
Displaying DRC Errors in a Hierarchical Design
The DRC Error Query Status form appears.

Note: You can also use this form to save your place in the error file so you can start with the 
same error when you begin the next session.

2. To display the status report, click left on Show Current Status.

The status text window appears.
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Now that you have seen the error status report containing information about all errors 
resulting from your hierarchical DRC run, you can close this text window.

1. To close the error status report, from the File menu, select Close Window.

Displaying Hcell Masters

When you display Hcells, the graphical user interface window can get cluttered, which makes 
it hard to see individual Hcells. To reduce the amount of data in the graphical user interface 
window, you can display the Hcell masters only. When there is less data in the graphical user 
interface window, you can locate and evaluate errors faster.

1. From the DRC menu, select Hierarchical Cell.

2. From the Handle Hcells form, click the Target Cell button as shown below. 

The Handle Hcells form has all options you specified earlier in this chapter.

Click Target 
Cell.
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The graphical user interface window is redrawn to show the via and contact Dracula 
layers in the context of the INV cell rather than the whole chip.
 

Quitting the Tutorial

If you’d like to continue, you can leave the windows you used for the tutorial on the screen, or 
you can close them. To close the windows, go to the “Closing Windows” section.

When you are ready to quit the Cadence software, go to the “Quitting Cadence Software” 
section.

Summary

In this chapter, you learned how to use graphical user interface to identify and display DRC 
errors in a hierarchical design. Specifically, you learned to

■ Start DRC from the graphical user interface

■ Select hierarchical DRC error files

■ Define how to display hierarchical DRC errors

Tools Design Window DRC LVS Short LPE Create Edit Verify Connectivity Options Route       
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■ Select Hcells with errors

■ Display Hcell errors

■ Verify DRC rules

■ Keep track of errors you’ve seen

■ Display Hcell masters

■ Quit the tutorial
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4
Analyzing LVS Errors

This chapter deals with Layout Versus Schematic (LVS) in the Dracula® graphical user 
interface product. This chapter covers the following topics:

■ About LVS

■ Starting the Dracula Graphical User Interface’s LVS

■ Interpreting the Discrepancy Report

■ Checking Netlist Connectivity

■ Displaying and Highlighting LVS Errors

■ Quitting the Tutorial

■ Summary

About LVS

Layout Versus Schematic (LVS) analysis is often the most time-consuming phase of the 
design verification process. The devices that cause errors in the layout can be difficult to 
locate if you have to manually zoom in and out to check each device listed in the LVS 
discrepancy report.

The graphical user interface’s LVS commands help you analyze and locate LVS errors faster. 
You can display the schematic netlist in one window and the corresponding Dracula layout in 
another window. You can also select data in one window, such as nets or devices in the netlist 
window, and display corresponding information in another window.

This chapter introduces you to some of the ways you can use the graphical user interface to 
display and identify Dracula LVS errors. The procedures help you find the short in the tutorial 
data. 

Note: There are many ways to identify LVS errors. Once you become familiar with the 
graphical user interface, the approach you use for your own designs might be different. 
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In this chapter, you’ll learn how to

■ Start the Dracula graphical user interface

■ Interpret the discrepancy report

■ Check netlist connectivity

■ Display and highlight LVS errors

■ Quit the Cadence software

Starting the Dracula Graphical User Interface’s LVS

Create and open an empty cell before you start this section. Chapter 1, “About the Dracula 
Graphical User Interface” explains how to create and open an empty cell.

Important

 Before you start graphical user interface’s LVS command, you also need to edit the 
first line of the CELLTABLE.HTV file in your /tutorial/dracrun directory to specify your 
complete directory path. You need to edit this file to display the netlist window.

Important

To edit the CELLTABLE.HTV file, follow these steps.

1. In your dracrun directory, use a text editor to open the CELLTABLE.HTV file.

2. Replace the path in the first line of the file with your full tutorial directory path:

<your_working_directory_path>/tutorial/dracrun/

Note: Don’t forget to add the final “/” character.

3. Save and exit the CELLTABLE.HTV file.

Accessing Dracula Error Files

Now you’ll start the graphical user interface and tell the software where to find your 
Dracula error files. If you haven’t started graphical user interface yet, read Chapter 1, “About 
the Dracula Graphical User Interface.”
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1. To display the LVS commands, click left on the LVS menu.

2. Select Setup from the LVS menu.

The LVS Setup form appears.

3. To tell the graphical user interface where to find your Dracula LVS files, type dracrun for 
the Dracula Data Path.

If you did not start the software in the directory where the Dracula LVS files are located, 
you must give the complete path to the files.

4. Click left on OK.

Note: The form takes a few seconds to disappear.

The View LVS form appears.

Now the graphical user interface knows where to find your Dracula LVS error files. Next you’ll 
open the discrepancy report that lists LVS errors.

These commands are in a 
lighter color to show that 
you can’t select them yet. 
To make these commands 
accessible, you need to run 
the Setup command.

Setup...
View LVS...
Open Netlist Window...
Show Network Hierarchy...
Show Discrepancy Report...
Node File...
Text File Handling
Hierarchical Cell...
Get Reference Window
Get Dracula Layer Window

Window DRC LVS    LPE Create Edit Verify Connectivity

Type dracrun 
here.

LVS Setup
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Interpreting the Discrepancy Report

When you run Dracula LVS, the software creates a discrepancy report that lists 
inconsistencies between the layout and schematic data. You use the information in the 
discrepancy window to determine which data you want to display in the netlist and graphical 
user interface windows. See the Dracula Reference Manual for a description of the 
discrepancy report format.

You can use the graphical user interface to find and display the devices listed in the 
discrepancy report. Next you’ll use graphical user interface to automatically display specific 
devices to help you locate the error in the sample Dracula layout. 

Displaying the Discrepancy Report

1. From the LVS menu, select Show Discrepancy Report.

The Show LVS Discrepancy Report form appears.

2. Click left on OK.

Important

When you are working on your own designs, the first thing you need to do is check 
the REDUCE SUMMARY REPORT section of the LVS report. If LVS reduces 
devices on the schematic and layout differently, you need to examine the 
connections to the devices and resolve the differences. If you do not resolve the 
differences, LVS cannot match the networks.

Important

For example, the following figure shows resistors that do not reduce identically. LVS 
reduces the schematic resistors in series to one resistor. However, because the 
layout resistors are connected to another node on the center net, LVS does not 
reduce them.
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The discrepancy report appears in a new window.

3. Check the REDUCE statistics in the report. 

The layout had 12790 MOS devices. REDUCE combined them into logic gates, leaving 
1752 MOS devices uncombined.

The schematic had 11378 MOS devices. REDUCE combined them to make the same 
logic gates it found in the layout and left the same number of uncombined MOS devices.

4. Scroll down to the LVS DEVICE MATCH SUMMARY.

You can see in the next figure that the layout and schematic each have one unmatched 
device. You use the discrepancies that follow to find out which devices are not matched. 
You use the highlight and cross-probing capability of the graphical user interface to find 
the unmatched devices in the layout and schematic.
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You can use File – Search in the discrepancy report window to search for any text string 
in the discrepancy report.

dracrun/lvsprt.lvs

Search
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5. Scroll the discrepancy report until you see DISCREPANCY 1 at the top of the window.

Discrepancy 1 is a matched node, net6439, with extra layout devices. The extra layout 
device is listed at the end of the discrepancy:

***** UN-MATCHED ***** : ?DEV15181 NAND
: X=1079.40 Y=706.50

X_rp-X_r2-w000062, 
X_rp-X_r2-w000304, net6439

Discrepancy 2 is a matched node, dataout<3>, with extra schematic devices. The extra 
schematic device is listed toward the end of the discrepancy:

?DEV13735 NAND :***** UN-MATCHED *****
X_rp-X_r2-w000062, dataout<3>, 
X_rp-X_r2-w000304

To scroll the discrepancy report window, 
click left here and hold.

Discrepancy 1 reports 
a matched node with 
extra layout devices.

Discrepancy 2 reports 
a matched node with 
an extra schematic 
device.

Discrepancies 3 and 4 
are matched nodes 
with unmatched 
devices.
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The unmatched devices are noted with ? preceding their names. The name of the 
unmatched layout device is the internal name given by Dracula.

Discrepancies 3 and 4 are nodes, X_rp-X_r2-w000304 and X_rp-X_r2-w000062, with 
unmatched devices, both layout and schematic.

These discrepancies indicate that nodes net6439 and dataout<3> might be connected 
incorrectly.

6. To make room on the screen for the other windows, iconify the discrepancy report 
window.

Now that you’ve used the discrepancy report to identify the devices that aren’t matched 
correctly, you’ll use the graphical user interface to locate the unmatched devices by 
highlighting the nets and devices in the layout and in the netlist.

Checking Netlist Connectivity

The netlist window lists the schematic netlist. This window makes it easier for you to compare 
the netlist connectivity to the Dracula layout data so you can identify inconsistencies.

You identified dataout<3> as a net with an extra schematic device and net6439 as a net with 
an extra layout device. Now you’ll display these nets in the netlist window and in the layout 
window to see where they appear.

Opening the Netlist Window

1. From the LVS menu, select Open Netlist Window.

The Open Netlist Window form appears.

2. Click left on OK.

rpu1 is the top-
level cell name.

rput
September 2023 58 Product Version IC23.1
© 2023                                                                                                                                                               All Rights Reserved.



Dracula Graphical User Interface Tutorial
Analyzing LVS Errors
The netlist window appears. If the netlist window doesn’t appear, see “Starting the 
Dracula Graphical User Interface’s LVS” on page 52 for details about what you need to 
do.

3. To minimize how much the windows overlap, resize the layout and netlist windows and 
place them side by side.

4. In the graphical user interface window, from the icon menu select Fit Edit.

Note: The locations of the commands in your icon menu might be different. To identify a 
command name in the icon menu, move the cursor over an icon.

Now you are ready to show the nets.

Displaying and Highlighting LVS Errors

The discrepancy report lists discrepancies between schematic and layout devices. Based on 
this information, you’ll highlight the discrepancies in both the graphical user interface and 
netlist windows to help you identify the error. 

Displaying Nets and Devices in the Dracula Graphical User Interface and 
Netlist Windows

Now you’ll highlight nets and devices in the graphical user interface and netlist windows.

Click left on the Fit Edit icon.
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1. In the Error Hilite section of the View LVS form, in the Number field type 1.

When you looked at the discrepancy report, you saw that discrepancy 1 listed net6439 
as a node with an extra layout device. Extra layout devices often indicate a misconnection 
in the layout, so you want to display this node in the graphical user interface window.

2. Click on Add.

To display 
discrepancy 1, the 
node with extra 
layout devices,
type 1 here.
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The node with extra layout devices, net6439, appears in the graphical user interface 
window. This node is also highlighted in the netlist window.

Because extra layout devices indicate a misconnection in the layout, you want to display 
any extra layout devices in the graphical user interface window.

Highlighting Unmatched Devices in the Dracula Graphical User Interface 
Window

In the discrepancy report, you saw the following discrepancies:

■ A node with an extra layout device

■ A node with an extra schematic device

■ Unmatched devices

You’ve already highlighted the node with an extra layout device. Now you will highlight the 
unmatched device for that node.

1. Select Net Hilite from the View LVS form.

Tools Design Window DRC LVS Short LPE Create Edit Verify Connectivity Options
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2. To highlight the unmatched devices on net6439, set the following options.:

3. Click left on Add.

The display for net6439 changes color and the unmatched devices are highlighted in 
white. The unmatched devices aren’t matched in the netlist, so they aren’t highlighted in 
the netlist window. 

Zooming In on the Unmatched Devices

To zoom in on the area around the unmatched devices in the graphical user interface window, 
follow these steps.

1. To view the unmatched devices, do one of the following:

❑ To zoom in around the unmatched devices, from the View LVS form, select Fit 
Current Hilite. 

❑ To get a larger view, use the Zoom Out icon.

To specify the net 
name, type net6439 
here.

To specify the 
unmatched devices, 
select Unmatched.

To highlight devices, 
select Devices for Net.
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The graphical user interface window zooms in on the area you specified. The enlarged 
image you see in this window makes it easier to see where the short occurs.

Now you can cross-probe the dataout<3> net from the netlist window to display it in the 
graphical user interface window.

Unmatched devices 

Tools Design Window DRC LVS Short LPE Create Edit Verify Connectivity Options 
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2. To select dataout<3>, double click left on it in the netlist window.

3. To identify where dataout<3> appears in the netlist window, select 
Dracula Interactive – Display Net.

The dataout<3> net is highlighted in a different color in all of the locations where it 
appears in the netlist window. The layout net matched to dataout<3> is highlighted in the 
graphical user interface window.

When you select a matched net in the netlist window, the graphical user interface window 
displays the layout node it matches. When you select a matched net in the graphical user 
interface window, the netlist window displays the schematic node it matches.

Identifying the Unmatched Devices

Now that you’ve highlighted the two nets with errors you’ll use other discrepancies to help 
identify the problem. Typically, it is easier to analyze LVS discrepancies for nets that have only 
a few devices.

1. Reopen the discrepancy report window.

dataout<3>

Dracula Interactive Netlist

Double-click on 
dataout<3>.
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2. Scroll down in the discrepancy report window to Discrepancy 4, node X_rp-X_r2-
w000062 with un-matched devices.

This discrepancy shows the unmatched schematic device and the unmatched layout 
device.
 

You can use the hierarchy information in the report to navigate through the netlist. 
Hierarchical names are listed as follows:

3. Iconify the discrepancy report window.

4. Double-click left on X_rp in the netlist window.

X_rp is the top-level instance. The dataout<3> and net6439 nets are inputs to X_rp.

5. To descend one level in the netlist hierarchy, select 
Show Subcircuit from the graphical user interface menu in the netlist window.

The netlist window displays the next lowest level. The subcircuit nets connected to 
dataout<3> and net6439 are highlighted in the same colors as in the parent.

6. In the netlist window scroll down to X_r2. 

X_rp-X_r2-w000062

hyphens used as delimiters

netsubcircuit
subcircuit instance
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X_r2 is highlighted in the same color as the dataout<3> net, which is one of its inputs.

7. Double click left on X_r2 in the netlist window. 

8. From the graphical user interface menu in the netlist window, select Show Subcircuit.

The NAND2_B device X_mod000623 is connected to nets w000062 and regin<3>. The 
regin<3> node is highlighted in the same color as dataout<3>, indicating that it is the 
same net as dataout<3>.
 

The discrepancy report lists the connections to a device in “output input input” order. In 
the discrepancy report, discrepancy 4 shows the unmatched layout device, DEV13735, 
connected to the following nets:

❑ X_rp-X_r2-w000062

❑ dataout<3>

❑ X_rp-X_r2-w000304

The output of DEV15181, the unmatched layout device, is connected to the same net, 
X_rp-X_r2-w000062, as the output of the unmatched schematic device. Its inputs are 
connected to

❑ X_rp-X_r2-w000304, the same net as one of the inputs to the unmatched schematic 
device

❑ net6439

Based on the discrepancy report you can conclude that DEV15181 should be connected 
to dataout<3> instead of net6439 and should match schematic device X_mod000623.

Dracula Interactive              File
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Quitting the Tutorial

At this point, you might want to continue working with graphical user interface. If you’d like to 
continue, you can leave the windows you used for the tutorial on the screen or you can close 
them. If you want to close the windows, go to the “Closing Windows” section.

When you are ready to quit the Cadence software, go to the “Quitting Cadence Software” 
section.

Summary

In this chapter, you learned how to use graphical user interface to analyze LVS errors. 
Specifically, you learned to

■ Start Dracula graphical user interface

■ Interpret the discrepancy report

■ Check netlist connectivity

■ Display and highlight LVS errors

■ Quit the Cadence software
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5
Displaying Parasitic Resistance and 
Capacitance

This chapter discusses parasitic resistance and capacitance in the Dracula® graphical user 
interface product. The chapter’s main focus is in the following areas:

■ About LPE/PRE

■ Starting LPE

■ Viewing Parasitic Capacitance

■ Viewing Parasitic Resistance

■ Quitting the Tutorial

■ Summary

About LPE/PRE

When you run an LPE or PRE job, Dracula creates files for each of the types of capacitance 
and resistance extracted. In this chapter, you’ll learn how to use graphical user interface to 
display Dracula parasitic extraction data. You’ll use the graphical user interface commands to 
locate and examine parasitics in these files automatically.

The procedures in this tutorial use Dracula output data files, not the original layout data. 
Because Dracula output data is in a different format, data you’ll see in this tutorial won’t look 
like your original layout data.

In this chapter, you will learn how to

■ Start the Dracula graphical user interface’s LPE

■ List nets with the highest parasitic capacitance

■ Display nets of your choice

■ Display nets with parasitic area and fringe capacitance 
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■ Display nets with parasitic coupling capacitance 

■ Display parts of a parasitic capacitor

■ List nets with the highest parasitic resistance

■ Display parts of a parasitic resistor

Starting LPE

Before you start this section, you need to open an empty cell, which is explained in “About the 
Dracula Graphical User Interface” section in Chapter 1. Once you have an empty cell open, 
you can go on with this section.

After you open the empty cell, the graphical user interface window appears. The graphical 
user interface window and the Layer Selection Window (LSW) are the only two windows open. 
You can ignore the LSW for now.

Looking at Dracula RC Data in the Dracula Graphical User Interface

Now you’ll tell the software where to find your Dracula RC data files.

1. Select Tools – Dracula Interactive if necessary.
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2. To display the LPE commands, click left on the LPE menu.

Except for the Setup submenu, you cannot enable any of the other submenus in the LPE 
pull-down menu until you perform step 3.

3. Select Setup from the LPE menu.

The LPE Setup form appears.

4. To tell the graphical user interface where to find your Dracula LPE/PRE files, in the 
Dracula Data Path field, type dracrc.

Customize

Type dracrc here.

LPE Setup
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If you did not start the software in the directory where the Dracula LPE/PRE files are 
located, you must type the complete path to the files.

5. Click left on OK.

Note: The form takes a few seconds to disappear. 

The RCV window appears on the right.

Now the graphical user interface knows where to find your Dracula LPE/PRE RC data files. 
Next you’ll list nets with parasitic capacitance.

Viewing Parasitic Capacitance

In this section, you’ll list nets with parasitic capacitance, select a net, and view its capacitance 
components.

Listing Nets with the Highest Parasitic Capacitance

1. To list nets with the highest parasitic capacitance, from the RCV form, select All Nets 
and With C.
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2. Click the top List button.

The Nets list box lists original nets in order from highest to lowest capacitance. You can 
scroll through the list of nets with the scroll bar.

3. To highlight the nets with the highest capacitance, select Hilite top.

The five nets with the highest capacitance are highlighted in the layout window, because 
Hilite top is set to 5 by default. You can highlight up to nine nets with the highest 
capacitance by filling in a number of your choice, from 1 to 9, in the Hilite top field.

4. To zoom in on the highlighted nets, click Fit Current Hilite.

Now that you’ve listed all the nets with the highest capacitance, you’re ready to list 
specific nets to view.

Listing Specific Nets

When you only want to look at certain nets, you can list the nets you want to display in an 
ASCII text file.

1. With a text editor such as vi, emacs, or textedit, create a text file in the dracrc 
subdirectory that contains the following lines:

?o64
?o21
?o88

Tools Design Window DRC LVS Short LPE Create Edit Verify 
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2. Save the text file as TARGET.DAT.

3. In the RCV form, select Target Nets, then click the top List button.

The nets you listed in TARGET.DAT are displayed in the Nets list box.

4. In the RCV form, experiment by selecting With C and List; With R and List; and Original 
and List.

You just listed nets that can be displayed. Next you’ll select a single parasitic capacitance net 
to display.

Displaying Capacitance Components for a Net

To display capacitance components, you select a net from the Nets list box. You will then list 
the capacitance components for this net and highlight them.

1. In the RCV form, click Clear All.

2. Select All Nets and With C, then click List.

RCV

Click List.

Select Target Nets.

Add De List CurrentCursor Pk
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3. To select a net with components to view, click on the fourth net listed in the Nets list box, 
original net 15 (?o15).

The net is highlighted in the graphical user interface layout window. Because C is 
selected, a C’s list box opens to list the components of parasitic capacitance to the target 
net.

4. To highlight an area or fringe component of parasitic capacitance to the target net

❑ Be sure C is selected.

❑ In the C’s list box, scroll down and click on the following component:

:20 ?o18:11 Z 7.59495E+02

RCV

When you select C or C_Gnd this 
list box displays parasitic 
capacitance components of the 
selected net.

Tools Design Window DRC LVS Short LPE Create Edit 

Ad D Cursor List 
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The current component is highlighted in white.

5. To unhighlight the component, click Remove next to the C’s list box.

6. To highlight a component of capacitance to ground for the target net

❑ Select C_Gnd.

❑ In the C’s list box, scroll to the top and click on the following component:

:16 ?o8:17 K 2.59250E+02

7. To highlight a component of coupling capacitance for the target net

❑ Select Aggr.

❑ Click on the following component in the Aggressors list box.

?o18 2.54181E+03

Tool  Design  Windows  DRC  LVS  Short  LPE  Create  Edit Verify 
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A corresponding C’s list box lists the different capacitance components for this coupling 
capacitance.

Now that you are able to view the different parasitic capacitance components for a 
selected net, you might want to find out what a component is and how it was extracted.

Getting Information About Capacitance Components

1. To list the extraction rule that created a capacitance component, in the RCV form

❑ Click on the following component in the C’s list box under the Aggressors list box:

:15 ?o18:17 Z 8.77355E+02

❑ Click Explain.

RCV

When you select Aggr., this list box 
displays parasitic components of the 
coupling capacitance.

AddDelCursor List 

Tool  Design  Window  DRC  LVS  Short  LPE  Create  Edit 
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❑ Click on the highlighted shape in the layout window.
 

If you need room on the screen, you can make this window smaller or close it.

2. List the area and fringe components of net ?o15 by clicking the C button.

3. In the C’s list box, scroll down to the following component and click on it.

:21 ?o18:19 Z 7.52957E+02

RCV

Click the C 
button.

Add     Del       Cursor Pk                
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4. To see how the parts of a parasitic capacitor were extracted, use Term 1, Term 2, and 
Whole to highlight the terminals of the capacitor listed in the C’s list box.

5. Click Clear All.

When you’re finished seeing how Dracula extracted parasitic capacitors, you’re ready to 
display parasitic resistance.

Viewing Parasitic Resistance

Now that you’ve looked at nets with parasitic capacitance, you’re ready to look at nets with 
parasitic resistance. You’ll follow very similar procedures.

Listing Nets with the Highest Parasitic Resistance

1. To list nets with the highest parasitic resistance, from the RCV form, select All Nets and 
With R.

Tool  Design  Windows  DRC  LVS  Short  LPE  Create  Edit Verify 
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2. Click List.

The Nets list box lists original nets in order from highest to lowest resistance. You can 
scroll through the list of nets with the scroll bar.

3. To highlight the nets with the highest resistance, select Hilite top.

The five nets with the highest resistance are highlighted in the layout window, because 
Hilite top is set to 5 by default. You can highlight up to nine nets with the highest 
resistance by filling in a number of your choice, from 1 to 9, in the Hilite top field.

RCV

De List CurrentCursor PkAdd
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4. To zoom in on the nets, click Fit Current Hilite.

5. Click Clear All.

Displaying Resistance Components for a Net

1. Click on ?o15, the first net listed in the Nets list box.
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The net is highlighted in the graphical user interface layout window. Because R is 
selected, an R’s list box opens to list the components of parasitic resistance to the target 
net.

2. To highlight a component of parasitic resistance to the target net, click on RR483, the first 
item in the R’s list box.

The current component is highlighted in white.

3. To remove the highlighting, click the Remove button for the R’s list box.

Getting Information About Resistance Components

1. Click on RR491, the second component in the R’s list box.

The first is unhighlighted, and the second is now highlighted in white.

2. To list the extraction rule that created a resistance component, in the RCV form

❑ Click Explain.

RCV

De Cursor PkAdd List Current
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❑ Click on the highlighted shape in the layout window.

3. To view the parts of a parasitic resistor, use Term 1, Term 2, Body, and Whole to highlight 
the terminals of the resistor listed in the R’s list box.

Quitting the Tutorial

At this point, you might want to continue working with the graphical user interface. If you’d like 
to continue, you can leave the windows you used for the tutorial on the screen, or you can 
close them. If you want to close the windows, go to the “Closing Windows” section.

When you are ready to quit the Cadence software, go to the “Quitting Cadence Software” 
section.
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Summary

You’ve now finished the Dracula Graphical User Interface Tutorial.

In this chapter, you learned how to use graphical user interface to list and display parasitic 
capacitance and resistance in a design. Specifically, you learned to

■ Start the graphical user interface’s LPE

■ List nets with the highest parasitic capacitance

■ Display only the nets listed in a text file

■ Display nets with parasitic area, fringe, and coupling capacitance components

■ Get information about capacitance components

■ List nets with the highest parasitic resistance

■ Get information about resistance components

■ Quit the tutorial
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Index
A
accessing

commands 14
errors automatically 9

aggressor nets 76
All in Active Rule 39
All in Visible Rules 39
analyzing LVS errors 51
area capacitance 75

B
buttons, form 14

C
capacitance

area/fringe 75
coupling 76
displaying components 74
getting information about 77
listing nets 72
to ground 76
viewing terminals/body 79

cells, empty 15
CELLTABLE.HTV file 52
CIW 13
Close Window command 31
closing text windows 32
Command Interpreter Window 13
commands

Close Window command 31
Display Layers command 43
Display Net command 64
Display Options command 23, 39
Error Status command 30, 45
Fit Edit command 59
Fit Next Error in Current Placement 

command 45
Open Netlist Window command 58
Ruler command 28, 44
See also commands, using 14
Select Cells command 47

Setup command
DRC menu 21, 36
LPE menu 71
LVS menu 53

Show Discrepancy Report 
command 54

commands, using
accessing 14
canceling 14, 17
getting help 14
selecting 14, 36

composite errors 38
conventions, menu commands 8
correcting Dracula errors 10
coupling capacitance 76
Create Dummy InQuery Cell form 15
creating empty cells 15
cycling through DRC errors 22

D
data

format 36
layout 10
tutorial 11

dataout<3>, highlighting in the netlist 
window 64

default form settings 14
descending hierarchy 65
devices

displaying 54, 59
highlighting 59

directories
creating 11
dracrc 11
dracrun 11
drchier 11

discrepancy report window 54, 57
Display Layers command 43
Display Net command 64
Display Options command 23, 39
displaying

capacitor terminals/body 79
devices 54, 59
errors
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Dracula 10
DRC error files 24
DRC error flags 23
hierarchical DRC error files 37
hierarchical DRC error flags 39
LVS 51

Hcells with errors 42, 47
layers 43
layout data 10
nets 64
nodes with extra layout devices 61
resistor terminals/body 83

DLW. See Dracula Layer Window
dracrc directory 11
dracrun directory 11
Dracula error files 19, 36
Dracula errors

displaying 10
locating 9

Dracula Layer Window 22
DRC

displaying
error files 24
error flags 23
hierarchical error files 37
hierarchical error flags 39

errors
cycling through 22
displaying 24
keeping track of 29
verifying 27

explaining rules 43
identifying violations 27, 43
menu commands 20, 36
verifying rules 43

DRC Error Query Status form 30, 46
DRC Options form 23, 26, 39
DRC Setup form 21
drchier directory 11
dummy cells. See empty cells 15

E
empty cells

creating 15
opening 16
reopening 18

Error Status command 30, 45
errors

analyzing automatically 9

composite 38
cycling through 22
explaining 27
explanations, verifying 10
files 24, 37
flags 23, 39
Hcell and composite-to-Hcell 38
Hcells 42, 47
keeping track of 45
locating 9
LVS 51
status 29
status report 29, 45
status, saving 30, 46

exiting Cadence software 33
explaining

DRC rules 43
parasitic capacitance 77
parasitic resistance 82

F
files

CELLTABLE.HTV 52
DAT 38
DRC error 24
ENC 38
for tutorial 11
hierarchical DRC error 37
LPE/PRE output 71
LVS report 54
status text file 31
TARGET.DAT 74

finding. See locating 9
Fit Edit command 59
Fit Next Error in Current Placement 

command 45
flags, error 23, 39
format

data 36
layout data 19

forms
buttons 14
Create Dummy InQuery Cell 15
default settings 14
DRC Error Query Status 30, 46
DRC Options 23, 26, 39
DRC Setup 21
Handle Hcells 40, 47
LPE Setup 71
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LVS Setup 53
Open File 17
Open Netlist Window 58
RCV 72
Select DRC Error Files 37
Show LVS Discrepancy Report 54
using 13
View LVS 60

fringe capacitance 75

H
Handle Hcells form 40, 47
Hcell and composite-to-Hcell errors 38
Hcells with errors

displaying 42, 47
selecting 40

Hierarchical Cell command 40
hierarchy, descending 65
highlighting

area/fringe capacitance 
components 75

capacitance components 74
capacitance nets 73
capacitance to ground 76
dataout<3> 64
devices 59
resistance components 81
resistance nets 80
unmatched devices 61

I
icon menu

Fit Edit command 59
Ruler command 28, 44

identifying
DRC violations 27, 43
LVS errors 51
parasitic capacitance 77
parasitic resistance 82

input line, CIW 13
InQuery

starting from the CIW 12
installation instructions 7

K
keeping track of errors 9, 29, 45

L
layers, displaying 43
layout

data 10
data format 19
tools 10

levels, ascending and descending 65
locating

Dracula errors 9
LVS errors 51
shorts 51

LPE Setup form 71
LPE/PRE

highlighting capacitance nets 73
highlighting resistance nets 80
listing parasitic capacitance nets 72
listing parasitic resistance nets 79

LVS
discrepancy report 54
errors, analyzing 51
menu commands 53

LVS Setup form 53

M
measuring. See ruler 28
menu banner, CIW 13
menu commands

DRC 20, 36
LPE 71
LVS 53

menu commands, selection conventions 8
menus, using 13
mouse, using 14

N
netlist window 58, 64
nets 64

aggressor 76
listing capacitance 72
listing resistance 79
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listing user-selected 73
with parasitic capacitance 72
with parasitic resistance 79

nodes with extra layout devices 61

O
Open File form 17
Open Netlist Window command 58
Open Netlist Window form 58
opening empty cells 16
output area, CIW 13

P
parasitic capacitance

area/fringe 75
coupling 76
displaying components 74
getting information about 77
listing nets 72
to ground 76
viewing terminals/body 79

parasitic resistance
displaying components 81
getting information about 82
listing nets 79

prompt line, CIW 13

Q
quitting

Cadence software 33
the tutorial 31

R
RCV form 72
Reference window 22
removing the ruler 29, 45
reports

discrepancy 54
error status 29, 45

resistance
displaying components 81
getting information about 82
listing nets 79

resizing windows 59
ruler

creating 28, 44
removing 29, 45

Ruler command 28, 44
Rules Layer Window 23, 38
rules, verifying DRC 43

S
sample tutorial data 19, 36
saving error status 30, 46
schematic netlist. See netlist window 51
scrolling discrepancy report window 57
Select Cells command 47
Select DRC Error Files form 37
selecting

commands 14, 36
Hcells with errors 40

setting up Cadence software 12
Setup command

DRC menu 21, 36
LPE menu 71
LVS menu 53

shorts, locating 51
Show Discrepancy Report command 54
Show LVS Discrepancy Report form 54
starting

Cadence software 12
InQuery 20
InQuery from CIW 12
standalone InQuery 14

status text file 31

T
TARGET.DAT file 74
text windows, closing 32
tracking errors 9, 29, 45
traversing the hierarchy, descending one 

level 65
tutorial directories

creating 11
dracrc 11
dracrun 11
drchier 11
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U
unmatched devices, highlighting 61
using

forms 13
menus 13
mouse 14
ruler 28, 44

V
verifying

DRC rules 43
error explanations 10

View DRC Error window 22, 25, 42
View LVS form 60
Virtuoso Layout Editor 10

W
window title, CIW 13
windows

closing 32
Command Interpreter Window 

(CIW) 12
discrepancy report window 54
Dracula Layer Window
netlist 58
Reference 22
resizing 59
Rules Layer Window 23, 38
View DRC Error 22, 25, 42
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